
Created in COMSOL Multiphysics 6.3
A M i c r oma ch i n e d  Comb -D r i v e
T un i n g  Fo r k  Ra t e  Gy r o s c op e
This model is licensed under the COMSOL Software License Agreement 6.3.
All trademarks are the property of their respective owners. See www.comsol.com/trademarks.

http://www.comsol.com/sla
http://www.comsol.com/trademarks/


Introduction

This tutorial model of a comb-drive tuning fork gyroscope is kindly provided by Dr. James 
Ransley at Veryst Engineering, LLC. The model demonstrates fully parameterized 
geometry, extensive use of selection features, implementation of analytic formulas for the 
electromechanical forces and response estimation, and comparison of numerical results 
with analytical estimations. In particular, extrusion operators are used to compute the 
distances between electrodes for force calculation. The device is loosely based on Ref. 1.

Model Definition

The geometry of the device is shown in the figure below. All dimensions and numbers of 
etch holes and comb fingers are parameterized in the model. Various selection features are 
used for the construction of the geometry and the setup of position-dependent variables, 
physics, and mesh.

Figure 1: The geometry of the gyroscope.

The gyroscope is composed of two proof masses supported by springs anchored to the 
substrate (not explicitly modeled). The comb drive excites the drive mode with the two 
masses oscillating along the X-axis in opposite directions. The device is designed to sense 
rotations around the Y-axis. The combination of such rotations and the drive-mode 
motion causes a Coriolis force in the positive and negative Z directions, which excites the 
out-of-plane sense-mode oscillation of the two masses. The sense-mode oscillation is 
picked up capacitively with electrodes in the substrate.
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The combs are assumed to be DC-biased at 60 V and AC-excited at 3 V. The sense 
electrodes are assumed to be DC-biased at 5 V. While a predefined Electromechanics 
multiphysics coupling is available with the MEMS Module, this model demonstrates the 
use of analytic formulas for computing the electrostatic forces.

The implementation of the parallel plate capacitor forces in the model is based on the 
expression for the force per unit area between two parallel plates of infinite extent with a 
dielectric medium of relative permittivity 1 (air or vacuum) in between:

 (1)

Here, ε0 is the permittivity of free space and d is the distance between the plates. This work 
uses this formula locally to approximate the forces between electrodes even when the 
plates are slightly misaligned, or near the edges of a structure where fringing fields might 
be important. These approximations make the model much more scalable and eliminate 
the need to solve for the field explicitly. They can be improved by adding empirically tuned 
fringing factors, determined by explicit calculations of the capacitance of the device.

The distance between the parallel plates can be determined using extrusion operators with 
the mesh search method set to “closest point” in the advanced settings. The operators will 
return the value of a given quantity at the closest point on the source surface, which is 
chosen to be the opposite plate of the capacitor. To ensure that the Jacobian of the 
operators is handled correctly, it is necessary to ensure that the dependent variables appear 
explicitly within the extrusion operators, which is why the coordinates of the moving 
surfaces are represented as X+u, and so on, in the expressions.

To understand the formulas added to implement the comb drive forces, consider the 
equation for the total force on any electrostatic actuator by using the equation

 (2)

where C is the comb capacitance and x is the coordinate along the direction of travel of 
the comb. For this example, assume that the comb travels parallel to the x-axis; more 
sophisticated expressions can be employed to capture effects due to comb misalignment. 
For motion along the x-axis with a displacement of u, the corresponding capacitance per 
unit height of a comb face is given by

 (3)
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where C0 is the comb capacitance at zero displacement. The force per unit length of each 
vertical edge at the tip of the comb is therefore

 (4)

As in the case of the parallel plate capacitors, the fidelity of the model can be improved by 
the calibration of fringing factors based on the accurate computation of the real 
capacitance of the structure.

Also note that several other techniques were used in the creation of the model. The signs 
of the forces are handled by assigning variables with different values to different edges or 
surfaces of the geometry. COMSOL’s sophisticated perturbation machinery is used to 
automatically add AC forces to the model by means of the linper() operator. The model 
also uses a parameter AC_on to zero out the perturbation terms for stationary studies so 
that they do not appear in a misleading fashion in the postprocessing of stationary 
solutions.

To save time and file size, a relatively coarse mesh is used. Nevertheless, the mesh is 
parameterized to be ready for refinement studies. In the follow-up model, Manufacturing 
Variation Effects in a Micromachined Comb-Drive Tuning Fork Rate Gyroscope, the 
Deformed Geometry feature will be used to study the effects of manufacturing variations, 
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with the advantage that it keeps the same mesh while varying the geometry, thus avoiding 
unwanted variations caused by a different mesh being used for a different geometry.

Figure 2: The mesh used in the model.
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Results and Discussion

Figure 3 shows the stationary response of the device. The masses are pulled down slightly 
by the bias voltage of the sense electrodes. The masses do not move horizontally since the 
DC part of the comb drive forces for each mass are equal and in opposite directions so they 
cancel out.

Figure 3: Stationary response of the device.
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Figure 4 and Figure 5 show the eigenfrequencies and mode shapes of the in-plane drive 
mode and the out-of-plane sense mode, respectively. 

Figure 4: Drive mode shape. 

Figure 5: Sense mode shape. 
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The drive-mode and sense-mode resonant frequencies can be estimated with analytic 
formulas from standard textbooks (for example, Ref. 2). This can be done easily in a 
Parameters table in the model, as detailed in the Modeling Instructions section. The 
agreement between the numerical and analytic results is good; see Table 1.

Figure 6 shows the drive-mode displacement under the simulated operation. The 
amplitude can be read off from the color legend.

Figure 6: The drive mode displacement.

TABLE 1:  NUMERICAL AND ANALYTIC RESULTS OF THE DRIVE-MODE AND SENSE-MODE FREQUENCIES.

Drive mode Sense mode

Numerical 38 kHz 41 kHz

Analytic 40 kHz 45 kHz
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Figure 7 shows the sense-mode displacement. Due to the tilt of the masses, the amplitude 
is either read off the Evaluation 3D table after clicking around the centers of the masses, 
or evaluated using an average operator, as detailed in the Modeling Instructions section.

Figure 7: The sense-mode displacement.

The drive-mode and sense-mode amplitudes are also estimated with analytic formulas. The 
agreement between the numerical and analytic results is good; see Table 2.

Finally, the sensitivity in terms of the sense capacitance change per rotation rate, in the 
units of aF/(deg/s), is computed using two alternative methods. Both give the same value 
of 0.23 aF/(deg/s). The capacitance amplitude at the rotation rate of 100 deg/s is 23 aF.
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TABLE 2:  NUMERICAL AND ANALYTIC RESULTS OF THE DRIVE-MODE AND SENSE-MODE AMPLITUDES.

Drive mode Sense mode

Numerical 2.4 um 0.20 nm

Analytic 2.2 um 0.21 nm
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Application Library path: MEMS_Module/Sensors/
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Modeling Instructions

From the File menu, choose New.

N E W

In the New window, click Model Wizard.

M O D E L  W I Z A R D

1 In the Model Wizard window, click 3D.

2 In the Select Physics tree, select Structural Mechanics > Solid Mechanics (solid).

3 Click Add.

4 Click Study.

5 In the Select Study tree, select General Studies > Stationary.

6 Click Done.

G E O M E T R Y  1

The Model Wizard starts the COMSOL Desktop at the Geometry node. Take the 
opportunity to set the length unit to microns for convenience.

1 In the Model Builder window, under Component 1 (comp1) click Geometry 1.

2 In the Settings window for Geometry, locate the Units section.

3 From the Length unit list, choose µm.

Enter model parameters in separate Parameters nodes according to the purposes of the 
parameters. First the ones for the geometry and mesh:

G L O B A L  D E F I N I T I O N S

Parameters 1 - Geometry & Mesh
1 In the Model Builder window, under Global Definitions click Parameters 1.
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2 In the Settings window for Parameters, type Parameters 1 - Geometry & Mesh in the 
Label text field.

3 Locate the Parameters section. In the table, enter the following settings:

Name Expression Value Description

l_mass 200[um] 2E-4 m Mass length

w_mass l_mass 2E-4 m Mass width

y_spring_l 350[um] 3.5E-4 m Y spring length

y_spring_w 10[um] 1E-5 m Y spring width

etch_dim 10[um] 1E-5 m Etch hole 
dimension

n_etch_x 8 8 Number of etch 
holes, x 
direction

n_etch_y 8 8 Number of etch 
holes, y 
direction

t_beam 12[um] 1.2E-5 m Structure layer 
thickness

w_anchor 5[um] 5E-6 m Anchor width

tether_x 55[um] 5.5E-5 m Tether beam x-
coordinate

x_spring_l 150[um] 1.5E-4 m X spring length

x_spring_w 4[um] 4E-6 m X spring width

tether_l 120[um] 1.2E-4 m Tether beam 
length

tether_w 8[um] 8E-6 m Tether beam width

w_stator_base 15[um] 1.5E-5 m Stator base width

rotor_stator_ov
erlap

40[um] 4E-5 m Rotor/stator 
overlap length

l_rotor 50[um] 5E-5 m Rotor comb length

w_rotor 8[um] 8E-6 m Rotor comb width

n_combs 8 8 Number of combs

t_anchor 2[um] 2E-6 m Anchor layer 
thickness

gap_combs 2[um] 2E-6 m Gap between combs
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Then create a new Parameters node for the physics settings. Note the parameter AC_on will 
be used to control the on/off of the AC driving voltage.

Parameters 2 - Physics
1 In the Home toolbar, click Parameters and choose Add > Parameters.

2 In the Settings window for Parameters, type Parameters 2 - Physics in the Label text 
field.

3 Locate the Parameters section. In the table, enter the following settings:

Create the geometry. Note how various Selection features are used to label collections of 
geometric objects to make it easier to set up physics and mesh later. Note how Boolean 
and Transform operations can inherit the Cumulative selection of their input objects. First 
build the proof masses.

rotor_spacing (w_mass-w_rotor*
n_combs)/
(n_combs+1)

1.5111E-5 m Spacing between 
rotor combs

w_stator rotor_spacing-2*
gap_combs

1.1111E-5 m Stator comb width

electrode_ratio 0.9 0.9 Ratio for 
dimension of 
sense electrode

delta 0.01[um] 1E-8 m Small distance 
for selections

mesh_factor 1 1 Mesh size factor 
(larger is bigger 
elements)

Name Expression Value Description

Vbase 5[V] 5 V Potential difference between mass 
and sense electrode

Vcomb 60[V] 60 V Potential difference between comb 
rotors and stators

Q 500 500 Resonator quality factor

V_ac 3[V] 3 V AC Comb voltage

Omega 0[deg/s] 0 rad/s Angular rotation rate

AC_on 0 0 1 to turn on AC drive, 0 otherwise

Name Expression Value Description
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G E O M E T R Y  1

Work Plane 1 - Mass
1 In the Geometry toolbar, click Work Plane.

2 In the Settings window for Work Plane, type Work Plane 1 - Mass in the Label text 
field.

Work Plane 1 - Mass (wp1) > Plane Geometry
In the Model Builder window, click Plane Geometry.

Rectangle 1 - Mass: +X
1 In the Work Plane toolbar, click Rectangle.

2 In the Settings window for Rectangle, type Rectangle 1 - Mass: +X in the Label text 
field.

3 Locate the Size and Shape section. In the Width text field, type l_mass.

4 In the Height text field, type w_mass.

5 Locate the Position section. From the Base list, choose Center.

6 In the xw text field, type y_spring_l/2.

7 Locate the Selections of Resulting Entities section. Find the Cumulative selection 
subsection. Click New.

8 In the New Cumulative Selection dialog, type Mass in the Name text field.

9 Click OK.

Rectangle 2 - Footprint of sense electrode
1 Right-click Rectangle 1 - Mass: +X and choose Duplicate.

2 In the Settings window for Rectangle, type Rectangle 2 - Footprint of sense 
electrode in the Label text field.

3 Locate the Size and Shape section. In the Width text field, type electrode_ratio*
l_mass.

4 In the Height text field, type electrode_ratio*w_mass.

Point 1 - For mesh copy
1 In the Work Plane toolbar, click Point.

2 In the Settings window for Point, type Point 1 - For mesh copy in the Label text field.

3 Locate the Point section. In the xw text field, type y_spring_l/2-electrode_ratio*
l_mass/2.

4 In the yw text field, type electrode_ratio*w_mass/5.
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5 Locate the Selections of Resulting Entities section. Find the Cumulative selection 
subsection. From the Contribute to list, choose Mass.

Work Plane 1 - Mass (wp1) > Rectangle 3 (r3)
1 In the Work Plane toolbar, click Rectangle.

2 In the Settings window for Rectangle, locate the Size and Shape section.

3 In the Width text field, type etch_dim.

4 In the Height text field, type etch_dim.

5 Locate the Position section. From the Base list, choose Center.

6 In the xw text field, type y_spring_l/2+w_mass/2-w_mass/(n_etch_x+1).

7 In the yw text field, type l_mass/2-l_mass/(n_etch_x+1).

8 Locate the Selections of Resulting Entities section. Find the Cumulative selection 
subsection. Click New.

9 In the New Cumulative Selection dialog, type Subtract in the Name text field.

10 Click OK.

Work Plane 1 - Mass (wp1) > Array 1 (arr1)
1 In the Work Plane toolbar, click Transforms and choose Array.

2 In the Settings window for Array, locate the Input section.

3 From the Input objects list, choose Subtract.

4 Locate the Size section. In the xw size text field, type n_etch_x.

5 In the yw size text field, type n_etch_y.

6 Locate the Displacement section. In the xw text field, type -w_mass/(n_etch_x+1).

7 In the yw text field, type -l_mass/(n_etch_x+1).

Work Plane 1 - Mass (wp1) > Difference 1 (dif1)
1 In the Work Plane toolbar, click Booleans and Partitions and choose Difference.

2 In the Settings window for Difference, locate the Difference section.

3 From the Objects to add list, choose Mass.

4 From the Objects to subtract list, choose Subtract.

Work Plane 1 - Mass (wp1) > Mirror 1 (mir1)
1 In the Work Plane toolbar, click Transforms and choose Mirror.

2 In the Settings window for Mirror, locate the Input section.

3 From the Input objects list, choose Mass.
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4 Select the Keep input objects checkbox.

Extrude 1 - Mass
1 In the Model Builder window, right-click Geometry 1 and choose Extrude.

2 In the Settings window for Extrude, type Extrude 1 - Mass in the Label text field.

3 Locate the Distances section. In the table, enter the following settings:

4 Locate the Selections of Resulting Entities section. Select the Resulting objects selection 
checkbox.

5 From the Show in physics list, choose All levels.

6 Click Build Selected.

Then build the anchors.

Work Plane 2 - Anchors
1 In the Geometry toolbar, click Work Plane.

2 In the Settings window for Work Plane, type Work Plane 2 - Anchors in the Label text 
field.

Work Plane 2 - Anchors (wp2) > Plane Geometry
In the Model Builder window, click Plane Geometry.

Rectangle 1 - Spring Anchor
1 In the Work Plane toolbar, click Rectangle.

2 In the Settings window for Rectangle, type Rectangle 1 - Spring Anchor in the Label 
text field.

3 Locate the Size and Shape section. In the Width text field, type w_anchor.

4 In the Height text field, type w_anchor.

5 Locate the Position section. From the Base list, choose Center.

6 In the xw text field, type tether_x.

7 In the yw text field, type l_mass/2+x_spring_l+y_spring_w/2-y_spring_w/2-
tether_l+w_anchor.

8 Locate the Selections of Resulting Entities section. Find the Cumulative selection 
subsection. Click New.

9 In the New Cumulative Selection dialog, type Anchors in the Name text field.

Distances (µm)

t_beam
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10 Click OK.

Rectangle 2 - Stator Anchor
1 Right-click Rectangle 1 - Spring Anchor and choose Duplicate.

2 In the Settings window for Rectangle, type Rectangle 2 - Stator Anchor in the Label 
text field.

3 Locate the Position section. In the xw text field, type y_spring_l/2+w_mass/2+
w_stator_base/2+2*l_rotor-rotor_stator_overlap.

4 In the yw text field, type l_mass/2-0.5*l_mass/(n_combs+1).

Work Plane 2 - Anchors (wp2) > Mirror 1 (mir1)
1 In the Work Plane toolbar, click Transforms and choose Mirror.

2 In the Settings window for Mirror, locate the Input section.

3 From the Input objects list, choose Anchors.

4 Select the Keep input objects checkbox.

Rectangle 3 - Stator Anchor 2
1 In the Model Builder window, under Component 1 (comp1) > Geometry 1 > 

Work Plane 2 - Anchors (wp2) > Plane Geometry right-click Rectangle 2 -

Stator Anchor (r2) and choose Duplicate.

2 In the Settings window for Rectangle, type Rectangle 3 - Stator Anchor 2 in the 
Label text field.

3 Locate the Position section. In the xw text field, type 0.

Work Plane 2 - Anchors (wp2) > Mirror 2 (mir2)
1 In the Work Plane toolbar, click Transforms and choose Mirror.

2 In the Settings window for Mirror, locate the Input section.

3 From the Input objects list, choose Anchors.

4 Select the Keep input objects checkbox.

5 Locate the Normal Vector to Line of Reflection section. In the xw text field, type 0.

6 In the yw text field, type 1.

Extrude 2 - Anchors
1 In the Model Builder window, right-click Geometry 1 and choose Extrude.

2 In the Settings window for Extrude, type Extrude 2 - Anchors in the Label text field.
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3 Locate the Distances section. In the table, enter the following settings:

4 Select the Reverse direction checkbox.

5 Locate the Selections of Resulting Entities section. Select the Resulting objects selection 
checkbox.

6 From the Show in physics list, choose All levels.

7 Click Build Selected.

Next build the springs.

Work Plane 3 - Springs
1 In the Geometry toolbar, click Work Plane.

2 In the Settings window for Work Plane, type Work Plane 3 - Springs in the Label text 
field.

Work Plane 3 - Springs (wp3) > Plane Geometry
In the Model Builder window, click Plane Geometry.

Rectangle 1 - Y Spring: +Y
1 In the Work Plane toolbar, click Rectangle.

2 In the Settings window for Rectangle, type Rectangle 1 - Y Spring: +Y in the Label 
text field.

3 Locate the Size and Shape section. In the Width text field, type y_spring_l+
x_spring_w.

4 In the Height text field, type y_spring_w.

5 Locate the Position section. From the Base list, choose Center.

6 In the yw text field, type l_mass/2+x_spring_l+y_spring_w/2.

7 Locate the Selections of Resulting Entities section. Find the Cumulative selection 
subsection. Click New.

8 In the New Cumulative Selection dialog, type Mirror Y in the Name text field.

9 Click OK.

Rectangle 2 - X Spring: +X +Y
1 In the Work Plane toolbar, click Rectangle.

Distances (µm)

t_anchor
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2 In the Settings window for Rectangle, type Rectangle 2 - X Spring: +X +Y in the 
Label text field.

3 Locate the Size and Shape section. In the Width text field, type x_spring_w.

4 In the Height text field, type x_spring_l+y_spring_w.

5 Locate the Position section. From the Base list, choose Center.

6 In the xw text field, type y_spring_l/2.

7 In the yw text field, type l_mass/2+x_spring_l/2+y_spring_w/2.

8 Locate the Selections of Resulting Entities section. Find the Cumulative selection 
subsection. Click New.

9 In the New Cumulative Selection dialog, type Mirror XY in the Name text field.

10 Click OK.

Rectangle 3 - Tether: +X +Y
1 In the Work Plane toolbar, click Rectangle.

2 In the Settings window for Rectangle, type Rectangle 3 - Tether: +X +Y in the Label 
text field.

3 Locate the Size and Shape section. In the Width text field, type tether_w.

4 In the Height text field, type tether_l+y_spring_w.

5 Locate the Position section. In the xw text field, type tether_x-tether_w/2.

6 In the yw text field, type l_mass/2+x_spring_l+y_spring_w/2-y_spring_w/2-
tether_l.

7 Locate the Selections of Resulting Entities section. Find the Cumulative selection 
subsection. From the Contribute to list, choose Mirror XY.

Work Plane 3 - Springs (wp3) > Mirror 1 (mir1)
1 In the Work Plane toolbar, click Transforms and choose Mirror.

2 In the Settings window for Mirror, locate the Input section.

3 From the Input objects list, choose Mirror XY.

4 Select the Keep input objects checkbox.

5 Locate the Normal Vector to Line of Reflection section. In the xw text field, type 0.

6 In the yw text field, type 1.

Work Plane 3 - Springs (wp3) > Mirror 2 (mir2)
1 In the Work Plane toolbar, click Transforms and choose Mirror.

2 In the Settings window for Mirror, locate the Input section.
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3 From the Input objects list, choose Mirror XY.

4 Select the Keep input objects checkbox.

Work Plane 3 - Springs (wp3) > Mirror 3 (mir3)
1 In the Work Plane toolbar, click Transforms and choose Mirror.

2 In the Settings window for Mirror, locate the Input section.

3 From the Input objects list, choose Mirror Y.

4 Locate the Normal Vector to Line of Reflection section. In the xw text field, type 0.

5 In the yw text field, type 1.

6 Locate the Input section. Select the Keep input objects checkbox.

Extrude 3 - Springs
1 In the Model Builder window, right-click Geometry 1 and choose Extrude.

2 In the Settings window for Extrude, type Extrude 3 - Springs in the Label text field.

3 Locate the Distances section. In the table, enter the following settings:

4 Locate the Selections of Resulting Entities section. Select the Resulting objects selection 
checkbox.

5 From the Show in physics list, choose All levels.

6 Click Build Selected.

Then build the rotor combs.

Work Plane 4 - Rotors
1 In the Geometry toolbar, click Work Plane.

2 In the Settings window for Work Plane, type Work Plane 4 - Rotors in the Label text 
field.

Work Plane 4 - Rotors (wp4) > Plane Geometry
In the Model Builder window, click Plane Geometry.

Rectangle 1 - 1st Comb
1 In the Work Plane toolbar, click Rectangle.

2 In the Settings window for Rectangle, type Rectangle 1 - 1st Comb in the Label text 
field.

3 Locate the Size and Shape section. In the Width text field, type l_rotor.

Distances (µm)

t_beam
19 |  A  M I C R O M A C H I N E D  C O M B - D R I V E   T U N I N G  F O R K  R A T E  G Y R O S C O P E



4 In the Height text field, type w_rotor.

5 Locate the Position section. From the Base list, choose Center.

6 In the xw text field, type y_spring_l/2+w_mass/2+l_rotor/2.

7 In the yw text field, type w_mass/2-rotor_spacing-w_rotor/2.

8 Locate the Selections of Resulting Entities section. Find the Cumulative selection 
subsection. Click New.

9 In the New Cumulative Selection dialog, type Rotors in the Name text field.

10 Click OK.

Work Plane 4 - Rotors (wp4) > Array 1 (arr1)
1 In the Work Plane toolbar, click Transforms and choose Array.

2 In the Settings window for Array, locate the Input section.

3 From the Input objects list, choose Rotors.

4 Locate the Size section. From the Array type list, choose Linear.

5 In the Size text field, type n_combs.

6 Locate the Displacement section. In the yw text field, type -(rotor_spacing+
w_rotor).

Work Plane 4 - Rotors (wp4) > Mirror 1 (mir1)
1 In the Work Plane toolbar, click Transforms and choose Mirror.

2 In the Settings window for Mirror, locate the Input section.

3 From the Input objects list, choose Rotors.

4 Select the Keep input objects checkbox.

5 Locate the Point on Line of Reflection section. In the xw text field, type y_spring_l/2.

Work Plane 4 - Rotors (wp4) > Mirror 2 (mir2)
1 In the Work Plane toolbar, click Transforms and choose Mirror.

2 In the Settings window for Mirror, locate the Input section.

3 From the Input objects list, choose Rotors.

4 Select the Keep input objects checkbox.

Extrude 4 - Rotors
1 In the Model Builder window, right-click Geometry 1 and choose Extrude.

2 In the Settings window for Extrude, type Extrude 4 - Rotors in the Label text field.
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3 Locate the Distances section. In the table, enter the following settings:

4 Locate the Selections of Resulting Entities section. Select the Resulting objects selection 
checkbox.

5 From the Show in physics list, choose All levels.

6 Click Build Selected.

Next build the stator combs.

Work Plane 5 - Stators
1 In the Geometry toolbar, click Work Plane.

2 In the Settings window for Work Plane, type Work Plane 5 - Stators in the Label text 
field.

Work Plane 5 - Stators (wp5) > Plane Geometry
In the Model Builder window, click Plane Geometry.

Rectangle 1 - 1st Comb
1 In the Work Plane toolbar, click Rectangle.

2 In the Settings window for Rectangle, type Rectangle 1 - 1st Comb in the Label text 
field.

3 Locate the Size and Shape section. In the Width text field, type l_rotor.

4 In the Height text field, type w_stator.

5 Locate the Position section. From the Base list, choose Center.

6 In the xw text field, type y_spring_l/2+w_mass/2+l_rotor/2+l_rotor-
rotor_stator_overlap.

7 In the yw text field, type w_mass/2-0.5*rotor_spacing.

8 Locate the Selections of Resulting Entities section. Find the Cumulative selection 
subsection. Click New.

9 In the New Cumulative Selection dialog, type Stators in the Name text field.

10 Click OK.

Work Plane 5 - Stators (wp5) > Array 1 (arr1)
1 In the Work Plane toolbar, click Transforms and choose Array.

2 In the Settings window for Array, locate the Input section.

Distances (µm)

t_beam
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3 From the Input objects list, choose Stators.

4 Locate the Size section. From the Array type list, choose Linear.

5 In the Size text field, type n_combs+1.

6 Locate the Displacement section. In the yw text field, type -(rotor_spacing+
w_rotor).

Rectangle 2 - Stator Base
1 In the Work Plane toolbar, click Rectangle.

2 In the Settings window for Rectangle, type Rectangle 2 - Stator Base in the Label 
text field.

3 Locate the Size and Shape section. In the Width text field, type w_stator_base.

4 In the Height text field, type w_mass-rotor_spacing+w_stator.

5 Locate the Position section. From the Base list, choose Center.

6 In the xw text field, type y_spring_l/2+w_mass/2+w_stator_base/2+2*l_rotor-
rotor_stator_overlap.

7 Locate the Selections of Resulting Entities section. Find the Cumulative selection 
subsection. Click New.

8 In the New Cumulative Selection dialog, type Stator Base in the Name text field.

9 Click OK.

Work Plane 5 - Stators (wp5) > Mirror 1 (mir1)
1 In the Work Plane toolbar, click Transforms and choose Mirror.

2 In the Settings window for Mirror, locate the Input section.

3 From the Input objects list, choose Stators.

4 Select the Keep input objects checkbox.

5 Locate the Point on Line of Reflection section. In the xw text field, type y_spring_l/2.

Work Plane 5 - Stators (wp5) > Mirror 2 (mir2)
1 In the Work Plane toolbar, click Transforms and choose Mirror.

2 In the Settings window for Mirror, locate the Input section.

3 From the Input objects list, choose Stators.

4 Select the Keep input objects checkbox.

Work Plane 5 - Stators (wp5) > Mirror 3 (mir3)
1 In the Work Plane toolbar, click Transforms and choose Mirror.

2 In the Settings window for Mirror, locate the Input section.
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3 From the Input objects list, choose Stator Base.

4 Select the Keep input objects checkbox.

Rectangle 3 - Stator Base
1 In the Work Plane toolbar, click Rectangle.

2 In the Settings window for Rectangle, type Rectangle 3 - Stator Base in the Label 
text field.

3 Locate the Size and Shape section. In the Width text field, type 2*(y_spring_l/2-
l_mass/2-l_rotor-(l_rotor-rotor_stator_overlap)).

4 In the Height text field, type w_mass-rotor_spacing+w_stator.

5 Locate the Position section. From the Base list, choose Center.

6 Locate the Selections of Resulting Entities section. Find the Cumulative selection 
subsection. From the Contribute to list, choose Stator Base.

Extrude 5 - Stators
1 In the Model Builder window, right-click Geometry 1 and choose Extrude.

2 In the Settings window for Extrude, type Extrude 5 - Stators in the Label text field.

3 Locate the Distances section. In the table, enter the following settings:

4 Locate the Selections of Resulting Entities section. Select the Resulting objects selection 
checkbox.

5 From the Show in physics list, choose All levels.

6 Click Build Selected.

Then build the sense electrodes.

Work Plane 6 - Sense Electrodes
1 In the Geometry toolbar, click Work Plane.

2 In the Settings window for Work Plane, type Work Plane 6 - Sense Electrodes in 
the Label text field.

3 Locate the Plane Definition section. In the z-coordinate text field, type -t_anchor.

4 Locate the Selections of Resulting Entities section. Select the Resulting objects selection 
checkbox.

Distances (µm)

t_beam
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Work Plane 6 - Sense Electrodes (wp6) > Plane Geometry
In the Model Builder window, click Plane Geometry.

Rectangle 1 - Sense electrode
1 In the Work Plane toolbar, click Rectangle.

2 In the Settings window for Rectangle, type Rectangle 1 - Sense electrode in the 
Label text field.

3 Locate the Size and Shape section. In the Width text field, type electrode_ratio*
l_mass.

4 In the Height text field, type electrode_ratio*w_mass.

5 Locate the Position section. From the Base list, choose Center.

6 In the xw text field, type y_spring_l/2.

7 Locate the Selections of Resulting Entities section. Find the Cumulative selection 
subsection. Click New.

8 In the New Cumulative Selection dialog, type Sense electrode in the Name text field.

9 Click OK.

Point 1 - For mesh copy
1 In the Work Plane toolbar, click Point.

2 In the Settings window for Point, type Point 1 - For mesh copy in the Label text field.

3 Locate the Point section. In the xw text field, type y_spring_l/2-electrode_ratio*
l_mass/2.

4 In the yw text field, type electrode_ratio*w_mass/5.

5 Locate the Selections of Resulting Entities section. Find the Cumulative selection 
subsection. From the Contribute to list, choose Sense electrode.

Work Plane 6 - Sense Electrodes (wp6) > Mirror 1 (mir1)
1 In the Work Plane toolbar, click Transforms and choose Mirror.

2 In the Settings window for Mirror, locate the Input section.

3 From the Input objects list, choose Sense electrode.

4 Select the Keep input objects checkbox.

Finally build the symmetry plane for meshing.

Work Plane 7 - Symmetry Plane
1 In the Model Builder window, right-click Geometry 1 and choose Work Plane.
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2 In the Settings window for Work Plane, type Work Plane 7 - Symmetry Plane in the 
Label text field.

3 Locate the Plane Definition section. From the Plane list, choose yz-plane.

Work Plane 7 - Symmetry Plane (wp7) > Plane Geometry
In the Model Builder window, click Plane Geometry.

Work Plane 7 - Symmetry Plane (wp7) > Cross Section 1 (cro1)
1 In the Work Plane toolbar, click Cross Section.

2 In the Settings window for Cross Section, locate the Selections of Resulting Entities 
section.

3 Find the Cumulative selection subsection. Click New.

4 In the New Cumulative Selection dialog, type Symmetry Plane in the Name text field.

5 Click OK.

Form Union (fin)
1 In the Home toolbar, click Build All.

2 In the Model Builder window, under Component 1 (comp1) > Geometry 1 click 
Form Union (fin).
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Now create additional selections to make it easy to set up the physics and mesh. Turn on 
wireframe rendering to see the selection more easily.

D E F I N I T I O N S

Box 1 - Bottom of Beam
1 In the Definitions toolbar, click Box.

2 In the Settings window for Box, type Box 1 - Bottom of Beam in the Label text field.

3 Locate the Geometric Entity Level section. From the Level list, choose Boundary.

4 Locate the Box Limits section. In the z minimum text field, type -delta.

5 In the z maximum text field, type delta.

6 Locate the Output Entities section. From the Include entity if list, choose 
Entity inside box.

7 Click the Wireframe Rendering button in the Graphics toolbar.

Box 2 - Entire Beam Layer
1 In the Definitions toolbar, click Box.

2 In the Settings window for Box, type Box 2 - Entire Beam Layer in the Label text 
field.

3 Locate the Box Limits section. In the z minimum text field, type t_beam/2-delta.

4 In the z maximum text field, type t_beam/2+delta.

Box 3 - Anchor base
1 In the Model Builder window, right-click Box 1 - Bottom of Beam and choose Duplicate.

2 In the Settings window for Box, type Box 3 - Anchor base in the Label text field.

3 Locate the Box Limits section. In the z minimum text field, type -t_anchor-delta.

4 In the z maximum text field, type -t_anchor+delta.

Intersection 1 - Lower Electrode
1 In the Definitions toolbar, click Intersection.

2 In the Settings window for Intersection, type Intersection 1 - Lower Electrode in 
the Label text field.

3 Locate the Geometric Entity Level section. From the Level list, choose Boundary.

4 Locate the Input Entities section. Under Selections to intersect, click Add.

5 In the Add dialog, select Box 1 - Bottom of Beam in the Selections to intersect list.

6 Click OK.
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7 In the Settings window for Intersection, locate the Input Entities section.

8 Under Selections to intersect, click Add.

9 In the Add dialog, select Extrude 1 - Mass in the Selections to intersect list.

10 Click OK.

Create selections for the vertical walls of the comb drives.

Box 4 - Comb vertical walls 1
1 In the Definitions toolbar, click Box.

2 In the Settings window for Box, type Box 4 - Comb vertical walls 1 in the Label 
text field.

3 Locate the Geometric Entity Level section. From the Level list, choose Boundary.

4 Locate the Box Limits section. In the x minimum text field, type y_spring_l/2+
w_mass/2+l_rotor/2-delta.

5 In the x maximum text field, type y_spring_l/2+w_mass/2+l_rotor/2+delta.

6 In the y minimum text field, type -w_mass/2+delta.

7 In the y maximum text field, type w_mass/2-delta.

8 In the z minimum text field, type t_beam/2.

9 In the z maximum text field, type t_beam/2+delta.

Box 5 - Comb vertical walls 2
1 Right-click Box 4 - Comb vertical walls 1 and choose Duplicate.

2 In the Settings window for Box, type Box 5 - Comb vertical walls 2 in the Label 
text field.

3 Locate the Box Limits section. In the x minimum text field, type -(y_spring_l/2+
w_mass/2+l_rotor/2)-delta.

4 In the x maximum text field, type -(y_spring_l/2+w_mass/2+l_rotor/2)+delta.

Box 6 - Comb vertical walls 3
1 In the Model Builder window, right-click Box 4 - Comb vertical walls 1 and choose 

Duplicate.

2 In the Settings window for Box, type Box 6 - Comb vertical walls 3 in the Label 
text field.

3 Locate the Box Limits section. In the x minimum text field, type y_spring_l/2-
w_mass/2-l_rotor/2 -delta.

4 In the x maximum text field, type y_spring_l/2-w_mass/2-l_rotor/2+delta.
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Box 7 - Comb vertical walls 4
1 In the Model Builder window, right-click Box 5 - Comb vertical walls 2 and choose 

Duplicate.

2 In the Settings window for Box, type Box 7 - Comb vertical walls 4 in the Label 
text field.

3 Locate the Box Limits section. In the x minimum text field, type -(y_spring_l/2-
w_mass/2-l_rotor/2)-delta.

4 In the x maximum text field, type -(y_spring_l/2-w_mass/2-l_rotor/2)+delta.

Union 1 - Comb Vertical Walls
1 In the Definitions toolbar, click Union.

2 In the Settings window for Union, type Union 1 - Comb Vertical Walls in the Label 
text field.

3 Locate the Geometric Entity Level section. From the Level list, choose Boundary.

4 Locate the Input Entities section. Under Selections to add, click Add.

5 In the Add dialog, in the Selections to add list, choose Box 4 - Comb vertical walls 1, 
Box 5 - Comb vertical walls 2, Box 6 - Comb vertical walls 3, and Box 7 -

Comb vertical walls 4.

6 Click OK.

Intersection 2 - Stator Vertical Walls
1 In the Definitions toolbar, click Intersection.

2 In the Settings window for Intersection, type Intersection 2 - Stator Vertical 
Walls in the Label text field.

3 Locate the Geometric Entity Level section. From the Level list, choose Boundary.

4 Locate the Input Entities section. Under Selections to intersect, click Add.

5 In the Add dialog, in the Selections to intersect list, choose Union 1 - Comb Vertical Walls 
and Extrude 5 - Stators.

6 Click OK.

Create selections for the end edges of the comb drives.

Box 8 - Rotor tip edge 1
1 In the Model Builder window, right-click Box 4 - Comb vertical walls 1 and choose 

Duplicate.

2 In the Settings window for Box, type Box 8 - Rotor tip edge 1 in the Label text field.

3 Locate the Geometric Entity Level section. From the Level list, choose Edge.
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4 Locate the Box Limits section. In the x minimum text field, type y_spring_l/2+
w_mass/2+l_rotor-delta.

5 In the x maximum text field, type y_spring_l/2+w_mass/2+l_rotor+delta.

Box 9 - Rotor tip edge 2
1 Right-click Box 8 - Rotor tip edge 1 and choose Duplicate.

2 In the Settings window for Box, type Box 9 - Rotor tip edge 2 in the Label text field.

3 Locate the Box Limits section. In the x minimum text field, type -(y_spring_l/2+
w_mass/2+l_rotor)-delta.

4 In the x maximum text field, type -(y_spring_l/2+w_mass/2+l_rotor)+delta.

Box 10 - Rotor tip edge 3
1 In the Model Builder window, right-click Box 8 - Rotor tip edge 1 and choose Duplicate.

2 In the Settings window for Box, type Box 10 - Rotor tip edge 3 in the Label text 
field.

3 Locate the Box Limits section. In the x minimum text field, type y_spring_l/2-
w_mass/2-l_rotor -delta.

4 In the x maximum text field, type y_spring_l/2-w_mass/2-l_rotor+delta.

Box 11 - Rotor tip edge 4
1 In the Model Builder window, right-click Box 9 - Rotor tip edge 2 and choose Duplicate.

2 In the Settings window for Box, type Box 11 - Rotor tip edge 4 in the Label text 
field.

3 Locate the Box Limits section. In the x minimum text field, type -(y_spring_l/2-
w_mass/2-l_rotor)-delta.

4 In the x maximum text field, type -(y_spring_l/2-w_mass/2-l_rotor)+delta.

Union 2 - Rotor Tip Edges +X DC
1 In the Definitions toolbar, click Union.

2 In the Settings window for Union, type Union 2 - Rotor Tip Edges +X DC in the 
Label text field.

3 Locate the Geometric Entity Level section. From the Level list, choose Edge.

4 Locate the Input Entities section. Under Selections to add, click Add.

5 In the Add dialog, in the Selections to add list, choose Box 8 - Rotor tip edge 1 and 
Box 11 - Rotor tip edge 4.

6 Click OK.
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Union 3 - Rotor Tip Edges -X DC
1 In the Definitions toolbar, click Union.

2 In the Settings window for Union, type Union 3 - Rotor Tip Edges -X DC in the 
Label text field.

3 Locate the Geometric Entity Level section. From the Level list, choose Edge.

4 Locate the Input Entities section. Under Selections to add, click Add.

5 In the Add dialog, in the Selections to add list, choose Box 9 - Rotor tip edge 2 and 
Box 10 - Rotor tip edge 3.

6 Click OK.

Union 4 - Rotor Tip Edges +X AC
1 In the Definitions toolbar, click Union.

2 In the Settings window for Union, type Union 4 - Rotor Tip Edges +X AC in the 
Label text field.

3 Locate the Geometric Entity Level section. From the Level list, choose Edge.

4 Locate the Input Entities section. Under Selections to add, click Add.

5 In the Add dialog, in the Selections to add list, choose Box 8 - Rotor tip edge 1 and 
Box 9 - Rotor tip edge 2.

6 Click OK.

Union 5 - Rotor Tip Edges -X AC
1 In the Definitions toolbar, click Union.

2 In the Settings window for Union, type Union 5 - Rotor Tip Edges -X AC in the 
Label text field.

3 Locate the Geometric Entity Level section. From the Level list, choose Edge.

4 Locate the Input Entities section. Under Selections to add, click Add.

5 In the Add dialog, in the Selections to add list, choose Box 10 - Rotor tip edge 3 and 
Box 11 - Rotor tip edge 4.

6 Click OK.

Union 6 - Rotor Tip Edges
1 In the Definitions toolbar, click Union.

2 In the Settings window for Union, type Union 6 - Rotor Tip Edges in the Label text 
field.

3 Locate the Geometric Entity Level section. From the Level list, choose Edge.

4 Locate the Input Entities section. Under Selections to add, click Add.
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5 In the Add dialog, in the Selections to add list, choose Union 2 - Rotor Tip Edges +X DC 
and Union 3 - Rotor Tip Edges -X DC.

6 Click OK.

Create selections for meshing.

Box 13 - x > 0 Beam base
1 In the Definitions toolbar, click Box.

2 In the Settings window for Box, type Box 13 - x > 0 Beam base in the Label text field.

3 Locate the Geometric Entity Level section. From the Level list, choose Boundary.

4 Locate the Box Limits section. In the x minimum text field, type -delta.

5 In the z minimum text field, type -delta.

6 In the z maximum text field, type delta.

7 Locate the Output Entities section. From the Include entity if list, choose 
Entity inside box.

Box 14 - x < 0 Beam base
1 Right-click Box 13 - x > 0 Beam base and choose Duplicate.

2 In the Settings window for Box, type Box 14 - x < 0 Beam base in the Label text field.

3 Locate the Box Limits section. In the x minimum text field, type -Inf.

4 In the x maximum text field, type delta.

Box 15 - x > 0 Spring Anchor
1 Right-click Box 14 - x < 0 Beam base and choose Duplicate.

2 In the Settings window for Box, type Box 15 - x > 0 Spring Anchor in the Label text 
field.

3 Locate the Box Limits section. In the x minimum text field, type -delta+tether_x-
w_anchor/2.

4 In the x maximum text field, type delta+tether_x+w_anchor/2.

Box 16 - x < 0 Spring Anchor
1 Right-click Box 15 - x > 0 Spring Anchor and choose Duplicate.

2 In the Settings window for Box, type Box 16 - x < 0 Spring Anchor in the Label text 
field.

3 Locate the Box Limits section. In the x minimum text field, type -delta-tether_x-
w_anchor/2.

4 In the x maximum text field, type delta-tether_x+w_anchor/2.
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Intersection 3 - Quad Mesh - Springs Construction
1 In the Definitions toolbar, click Intersection.

2 In the Settings window for Intersection, type Intersection 3 - Quad Mesh - 
Springs Construction in the Label text field.

3 Locate the Geometric Entity Level section. From the Level list, choose Boundary.

4 Locate the Input Entities section. Under Selections to intersect, click Add.

5 In the Add dialog, in the Selections to intersect list, choose Box 13 - x > 0 Beam base and 
Extrude 3 - Springs.

6 Click OK.

Intersection 4 - Quad Mesh - Springs Construction copy
1 In the Definitions toolbar, click Intersection.

2 In the Settings window for Intersection, type Intersection 4 - Quad Mesh - 
Springs Construction copy in the Label text field.

3 Locate the Geometric Entity Level section. From the Level list, choose Boundary.

4 Locate the Input Entities section. Under Selections to intersect, click Add.

5 In the Add dialog, in the Selections to intersect list, choose Box 14 - x < 0 Beam base and 
Extrude 3 - Springs.

6 Click OK.

Intersection 5 - Mapped Mesh - Anchors
1 In the Definitions toolbar, click Intersection.

2 In the Settings window for Intersection, type Intersection 5 - Mapped Mesh - 
Anchors in the Label text field.

3 Locate the Geometric Entity Level section. From the Level list, choose Boundary.

4 Locate the Input Entities section. Under Selections to intersect, click Add.

5 In the Add dialog, in the Selections to intersect list, choose Box 15 - x > 0 Spring Anchor 
and Extrude 2 - Anchors.

6 Click OK.

Intersection 6 - Mapped Mesh - Anchors copy
1 In the Definitions toolbar, click Intersection.

2 In the Settings window for Intersection, type Intersection 6 - Mapped Mesh - 
Anchors copy in the Label text field.

3 Locate the Geometric Entity Level section. From the Level list, choose Boundary.

4 Locate the Input Entities section. Under Selections to intersect, click Add.
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5 In the Add dialog, in the Selections to intersect list, choose Box 16 - x < 0 Spring Anchor 
and Extrude 2 - Anchors.

6 Click OK.

Intersection 7 - Triangular Mesh - Mass
1 In the Definitions toolbar, click Intersection.

2 In the Settings window for Intersection, type Intersection 7 - Triangular Mesh - 
Mass in the Label text field.

3 Locate the Geometric Entity Level section. From the Level list, choose Boundary.

4 Locate the Input Entities section. Under Selections to intersect, click Add.

5 In the Add dialog, in the Selections to intersect list, choose Box 13 - x > 0 Beam base and 
Extrude 1 - Mass.

6 Click OK.

Intersection 8 - Triangular Mesh - Mass copy
1 In the Definitions toolbar, click Intersection.

2 In the Settings window for Intersection, type Intersection 8 - Triangular Mesh - 
Mass copy in the Label text field.

3 Locate the Geometric Entity Level section. From the Level list, choose Boundary.

4 Locate the Input Entities section. Under Selections to intersect, click Add.

5 In the Add dialog, in the Selections to intersect list, choose Box 14 - x < 0 Beam base and 
Extrude 1 - Mass.

6 Click OK.

Difference 1 - Quad Mesh - Springs
1 In the Definitions toolbar, click Difference.

2 In the Settings window for Difference, type Difference 1 - Quad Mesh - Springs 
in the Label text field.

3 Locate the Geometric Entity Level section. From the Level list, choose Boundary.

4 Locate the Input Entities section. Under Selections to add, click Add.

5 In the Add dialog, select Intersection 3 - Quad Mesh - Springs Construction in the 
Selections to add list.

6 Click OK.

7 In the Settings window for Difference, locate the Input Entities section.

8 Under Selections to subtract, click Add.
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9 In the Add dialog, select Intersection 5 - Mapped Mesh - Anchors in the 
Selections to subtract list.

10 Click OK.

Difference 2 - Quad Mesh - Springs copy
1 In the Definitions toolbar, click Difference.

2 In the Settings window for Difference, type Difference 2 - Quad Mesh - Springs 
copy in the Label text field.

3 Locate the Geometric Entity Level section. From the Level list, choose Boundary.

4 Locate the Input Entities section. Under Selections to add, click Add.

5 In the Add dialog, select Intersection 4 - Quad Mesh - Springs Construction copy in the 
Selections to add list.

6 Click OK.

7 In the Settings window for Difference, locate the Input Entities section.

8 Under Selections to subtract, click Add.

9 In the Add dialog, select Intersection 6 - Mapped Mesh - Anchors copy in the 
Selections to subtract list.

10 Click OK.

Difference 3 - Quad Mesh -Stator & Comb
1 In the Definitions toolbar, click Difference.

2 In the Settings window for Difference, type Difference 3 - Quad Mesh -Stator & 
Comb in the Label text field.

3 Locate the Geometric Entity Level section. From the Level list, choose Boundary.

4 Locate the Input Entities section. Under Selections to add, click Add.

5 In the Add dialog, select Box 13 - x > 0 Beam base in the Selections to add list.

6 Click OK.

7 In the Settings window for Difference, locate the Input Entities section.

8 Under Selections to subtract, click Add.

9 In the Add dialog, in the Selections to subtract list, choose Box 15 - x > 0 Spring Anchor, 
Extrude 1 - Mass, Extrude 3 - Springs, and Work Plane 6 - Sense Electrodes.

10 Click OK.

Difference 4 - Quad Mesh -Stator & Comb copy
1 In the Definitions toolbar, click Difference.
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2 In the Settings window for Difference, type Difference 4 - Quad Mesh -Stator & 
Comb copy in the Label text field.

3 Locate the Geometric Entity Level section. From the Level list, choose Boundary.

4 Locate the Input Entities section. Under Selections to add, click Add.

5 In the Add dialog, select Box 14 - x < 0 Beam base in the Selections to add list.

6 Click OK.

7 In the Settings window for Difference, locate the Input Entities section.

8 Under Selections to subtract, click Add.

9 In the Add dialog, in the Selections to subtract list, choose Box 16 - x < 0 Spring Anchor, 
Extrude 1 - Mass, Extrude 3 - Springs, and Work Plane 6 - Sense Electrodes.

10 Click OK.

Box 17 - x > 0 Anchor base
1 In the Definitions toolbar, click Box.

2 In the Settings window for Box, type Box 17 - x > 0 Anchor base in the Label text 
field.

3 Locate the Geometric Entity Level section. From the Level list, choose Boundary.

4 Locate the Box Limits section. In the x minimum text field, type -delta.

5 In the z minimum text field, type -delta-t_anchor.

6 In the z maximum text field, type delta-t_anchor.

7 Locate the Output Entities section. From the Include entity if list, choose 
Entity inside box.

Box 18 - x < 0 Anchor base
1 Right-click Box 17 - x > 0 Anchor base and choose Duplicate.

2 In the Settings window for Box, type Box 18 - x < 0 Anchor base in the Label text 
field.

3 Locate the Box Limits section. In the x minimum text field, type -Inf.

4 In the x maximum text field, type delta.

Intersection 9 - Triangular Mesh - Sense Electrode
1 In the Definitions toolbar, click Intersection.

2 In the Settings window for Intersection, type Intersection 9 - Triangular Mesh - 
Sense Electrode in the Label text field.

3 Locate the Geometric Entity Level section. From the Level list, choose Boundary.
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4 Locate the Input Entities section. Under Selections to intersect, click Add.

5 In the Add dialog, in the Selections to intersect list, choose Box 17 - x > 0 Anchor base 
and Work Plane 6 - Sense Electrodes.

6 Click OK.

Intersection 10 - Triangular Mesh - Sense Electrode copy
1 In the Definitions toolbar, click Intersection.

2 In the Settings window for Intersection, type Intersection 10 - Triangular Mesh 
- Sense Electrode copy in the Label text field.

3 Locate the Geometric Entity Level section. From the Level list, choose Boundary.

4 Locate the Input Entities section. Under Selections to intersect, click Add.

5 In the Add dialog, in the Selections to intersect list, choose Box 18 - x < 0 Anchor base 
and Work Plane 6 - Sense Electrodes.

6 Click OK.

Finally create selection for the effective regions of the lower electrodes.

Box 19 - x > 0 Lower electrode effective region
1 In the Definitions toolbar, click Box.

2 In the Settings window for Box, type Box 19 - x > 0 Lower electrode effective 
region in the Label text field.

3 Locate the Geometric Entity Level section. From the Level list, choose Boundary.

4 Locate the Box Limits section. In the x minimum text field, type -delta+y_spring_l/
2-electrode_ratio*l_mass/2.

5 In the x maximum text field, type delta+y_spring_l/2+electrode_ratio*l_mass/
2.

6 In the y minimum text field, type -delta-electrode_ratio*w_mass/2.

7 In the y maximum text field, type delta+electrode_ratio*w_mass/2.

8 In the z minimum text field, type -delta.

9 In the z maximum text field, type delta.

10 Locate the Output Entities section. From the Include entity if list, choose 
Entity inside box.

Box 20 - x < 0 Lower electrode effective region
1 Right-click Box 19 - x > 0 Lower electrode effective region and choose Duplicate.
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2 In the Settings window for Box, type Box 20 - x < 0 Lower electrode effective 
region in the Label text field.

3 Locate the Box Limits section. In the x minimum text field, type -delta-y_spring_l/
2-electrode_ratio*l_mass/2.

4 In the x maximum text field, type delta-y_spring_l/2+electrode_ratio*l_mass/
2.

Union 7 - Lower electrode effective region
1 In the Definitions toolbar, click Union.

2 In the Settings window for Union, type Union 7 - Lower electrode effective 
region in the Label text field.

3 Locate the Geometric Entity Level section. From the Level list, choose Boundary.

4 Locate the Input Entities section. Under Selections to add, click Add.

5 In the Add dialog, in the Selections to add list, choose Box 19 - x >

0 Lower electrode effective region and Box 20 - x < 0 Lower electrode effective region.

6 Click OK.

While a predefined, fully-coupled Electromechanics multiphysics is available, in this 
model we demonstrate the use of analytic formulas for computing the electrostatic 
forces. Create extrusion and integration operators to be used in the analytic formulas.

7 In the Model Builder window, collapse the Component 1 (comp1) > Definitions > Selections 
node.

General Extrusion 1 - Stator Walls
1 In the Definitions toolbar, click Nonlocal Couplings and choose General Extrusion.

2 In the Settings window for General Extrusion, type General Extrusion 1 - Stator 
Walls in the Label text field.

3 In the Operator name text field, type genextcmb.

4 Locate the Source Selection section. From the Geometric entity level list, choose 
Boundary.

5 From the Selection list, choose Intersection 2 - Stator Vertical Walls.

6 Locate the Source section. Select the Use source map checkbox.

7 Click to expand the Advanced section. From the Mesh search method list, choose 
Closest point.

This extrusion operator will be used to compute the distance between the tips of the 
rotors to the vertical walls of the stators as part of the comb-drive force and capacitance 
calculation.
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General Extrusion 2 - Sense Electrodes
1 Right-click General Extrusion 1 - Stator Walls and choose Duplicate.

2 In the Settings window for General Extrusion, type General Extrusion 2 - Sense 
Electrodes in the Label text field.

3 In the Operator name text field, type genextpp.

4 Locate the Source Selection section. From the Selection list, choose Work Plane 6 -

Sense Electrodes.

This extrusion operator will be used to compute the distance between the sense 
electrodes to the bottom surfaces of the proof masses as part of the parallel-plate force 
and capacitance calculation.

Integration 1 - Lower Electrodes
1 In the Definitions toolbar, click Nonlocal Couplings and choose Integration.

2 In the Settings window for Integration, type Integration 1 - Lower Electrodes in 
the Label text field.

3 In the Operator name text field, type intoppp.

4 Locate the Source Selection section. From the Geometric entity level list, choose 
Boundary.

5 From the Selection list, choose Union 7 - Lower electrode effective region.

Integration 2 - Comb Edges
1 In the Definitions toolbar, click Nonlocal Couplings and choose Integration.

2 In the Settings window for Integration, type Integration 2 - Comb Edges in the Label 
text field.

3 In the Operator name text field, type intopcmb.

4 Locate the Source Selection section. From the Geometric entity level list, choose Edge.

5 From the Selection list, choose Union 6 - Rotor Tip Edges.

Now we are ready to enter the analytic formulas and other useful variables, first for the 
sense electrodes. Note how the extrusion operator is used to compute the gap distance 
between the parallel plate electrodes. Also a spatially dependent variable, sign, is created 
to provide the correct phase factor for the estimation of the sense mode amplitude (to be 
performed during postprocessing). The formula for the force on the parallel plate 
capacitor can be found in standard textbooks such as Ref. 2 (Chapter 15).

Variables 1 - Sense Capacitor
1 In the Model Builder window, right-click Definitions and choose Variables.
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2 In the Settings window for Variables, type Variables 1 - Sense Capacitor in the 
Label text field.

3 Locate the Geometric Entity Selection section. From the Geometric entity level list, 
choose Boundary.

4 From the Selection list, choose Union 7 - Lower electrode effective region.

5 Locate the Variables section. In the table, enter the following settings:

Variables 2 - Sense Capacitor + sign AC
1 Right-click Definitions and choose Variables.

2 In the Settings window for Variables, type Variables 2 - Sense Capacitor + sign 
AC in the Label text field.

3 Locate the Geometric Entity Selection section. From the Geometric entity level list, 
choose Boundary.

4 From the Selection list, choose Box 20 - x < 0 Lower electrode effective region.

5 Locate the Variables section. In the table, enter the following settings:

Variables 3 - Sense Capacitor - sign AC
1 Right-click Variables 2 - Sense Capacitor + sign AC and choose Duplicate.

2 In the Settings window for Variables, type Variables 3 - Sense Capacitor - sign 
AC in the Label text field.

Name Expression Unit Description

dpp_x genextpp(X)-(X+u) m Vector from lower 
electrode, x

dpp_y genextpp(Y)-(Y+v) m Vector from lower 
electrode, y

dpp_z genextpp(Z)-(Z+w) m Vector from lower 
electrode, z

dpp_sq dpp_x^2+dpp_y^2+dpp_z^2 m² Square of parallel 
plate distance

F_A 0.5*epsilon0_const*
Vbase^2/dpp_sq

Pa Force per unit area of 
electrode

C_A epsilon0_const/
sqrt(dpp_sq)

F/m² Capacitance per unit 
area of electrode

Name Expression Unit Description

sign 1 Sign of capacitance change
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3 Locate the Geometric Entity Selection section. From the Selection list, choose Box 19 -

x > 0 Lower electrode effective region.

4 Locate the Variables section. In the table, enter the following settings:

Then for the comb drives. Here since the force directions of the combs are different 
between the DC bias and the AC drive, two spatially dependent variables, sign and AC, 
are used to provide correct directions and phase factors. The linper operator is used to 
delineate the AC part of the drive voltage V_ac. In addition, the parameter AC_on is used 
to turn the AC drive on or off. The formula for the comb drive force can be found in 
standard textbooks such as Ref. 2 (Chapter 15). The formula gives the overall force from 
energy arguments. This overall force can be divided up into separate contributions in 
different parts of the model in various ways. In this model we choose to divide the overall 
force into edge loads at the tips of the rotors. Note how the extrusion operator is used to 
compute the distance between the edges and the vertical walls of the stators as part of the 
force calculation.

Variables 4 - Comb Drives
1 In the Model Builder window, right-click Definitions and choose Variables.

2 In the Settings window for Variables, type Variables 4 - Comb Drives in the Label 
text field.

3 Locate the Geometric Entity Selection section. From the Geometric entity level list, 
choose Edge.

4 From the Selection list, choose Union 6 - Rotor Tip Edges.

5 Locate the Variables section. In the table, enter the following settings:

Name Expression Unit Description

sign -1 Sign of capacitance change

Name Expression Unit Description

dcmb_x genextcmb(X+u)-(X+u) m Vector from 
rotor comb 
edge, x

dcmb_y genextcmb(Y+v)-(Y+v) m Vector from 
rotor comb 
edge, y

dcmb_z genextcmb(Z+w)-(Z+w) m Vector from 
rotor comb 
edge, z
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Variables 5 - Comb Drives + sign DC
1 Right-click Definitions and choose Variables.

2 In the Settings window for Variables, type Variables 5 - Comb Drives + sign DC 
in the Label text field.

3 Locate the Geometric Entity Selection section. From the Geometric entity level list, 
choose Edge.

4 From the Selection list, choose Union 2 - Rotor Tip Edges +X DC.

5 Locate the Variables section. In the table, enter the following settings:

Variables 6 - Comb Drives - sign DC
1 Right-click Variables 5 - Comb Drives + sign DC and choose Duplicate.

2 In the Settings window for Variables, type Variables 6 - Comb Drives - sign DC 
in the Label text field.

3 Locate the Geometric Entity Selection section. From the Selection list, choose Union 3 -

Rotor Tip Edges -X DC.

4 Locate the Variables section. In the table, enter the following settings:

Variables 7 - Comb Drives + sign AC
1 In the Model Builder window, right-click Definitions and choose Variables.

dcmb sqrt(dcmb_x^2+dcmb_y^2+dcmb_z^2) m Parallel 
plate 
distance

Vtot Vcomb+AC_on*AC*linper(V_ac) Total 
voltage

F_l sign*0.5*epsilon0_const*Vtot^2/
dcmb

Force per 
unit length 
of edge

C_l linpoint(epsilon0_const/dcmb)*u*
sign*AC

Capacitance 
change per 
unit length

Name Expression Unit Description

sign 1 Sign of comb drive force

Name Expression Unit Description

sign -1 Sign of comb drive force

Name Expression Unit Description
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2 In the Settings window for Variables, type Variables 7 - Comb Drives + sign AC 
in the Label text field.

3 Locate the Geometric Entity Selection section. From the Geometric entity level list, 
choose Edge.

4 From the Selection list, choose Union 4 - Rotor Tip Edges +X AC.

5 Locate the Variables section. In the table, enter the following settings:

Variables 8 - Comb Drives - sign AC
1 Right-click Variables 7 - Comb Drives + sign AC and choose Duplicate.

2 In the Settings window for Variables, type Variables 8 - Comb Drives - sign AC 
in the Label text field.

3 Locate the Geometric Entity Selection section. From the Selection list, choose Union 5 -

Rotor Tip Edges -X AC.

4 Locate the Variables section. In the table, enter the following settings:

Now add the Polycrystalline Silicon material from the library.

A D D  M A T E R I A L

1 In the Home toolbar, click Add Material to open the Add Material window.

2 Go to the Add Material window.

3 In the tree, select MEMS > Semiconductors > Si - Polycrystalline silicon.

4 Click the Add to Component button in the window toolbar.

5 In the Home toolbar, click Add Material to close the Add Material window.

Configure the physics settings. Use the previously defined variables for the electrostatic 
forces. Turn on the Coriolis Force option.

S O L I D  M E C H A N I C S  ( S O L I D )

Damping 1
1 In the Physics toolbar, click Attributes and choose Damping.

2 In the Settings window for Damping, locate the Damping Settings section.

Name Expression Unit Description

AC 1 Sign of AC comb voltage

Name Expression Unit Description

AC -1 Sign of AC comb voltage
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3 From the Damping type list, choose Isotropic loss factor.

4 From the ηs list, choose User defined. In the associated text field, type 1/Q.

Fixed Constraint 1
1 In the Physics toolbar, click Boundaries and choose Fixed Constraint.

2 In the Settings window for Fixed Constraint, locate the Boundary Selection section.

3 From the Selection list, choose Box 3 - Anchor base.

Boundary Load 1 - Sense Electrodes
1 In the Physics toolbar, click Boundaries and choose Boundary Load.

2 In the Settings window for Boundary Load, type Boundary Load 1 - Sense 
Electrodes in the Label text field.

3 Locate the Boundary Selection section. From the Selection list, choose Union 7 -

Lower electrode effective region.

4 Locate the Force section. Specify the fA vector as

Edge Load 1 - Comb Drives
1 In the Physics toolbar, click Edges and choose Edge Load.

2 In the Settings window for Edge Load, type Edge Load 1 - Comb Drives in the Label 
text field.

3 Locate the Edge Selection section. From the Selection list, choose Union 6 -

Rotor Tip Edges.

4 Locate the Force section. Specify the fL vector as

Rotating Frame 1
1 In the Physics toolbar, click Domains and choose Rotating Frame.

2 In the Settings window for Rotating Frame, locate the Rotating Frame section.

3 From the Axis of rotation list, choose y-axis.

4 In the Ω text field, type Omega.

5 Locate the Frame Acceleration Effect section. Select the Coriolis force checkbox.

Set up the mesh. To save time and file size, a somewhat coarse mesh is used. Nevertheless 
the mesh is parameterized to be ready for refinement studies. In the followup model, the 
Deformed Geometry feature will be used to study the effects of manufacturing tolerances, 

-F_A z

F_l x
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with the advantage that it keeps the same mesh while varying the geometry, thus avoiding 
unwanted variations caused by a different mesh being used for a different geometry.

M E S H  1

Mapped 1
1 In the Mesh toolbar, click More Generators and choose Mapped.

2 In the Settings window for Mapped, locate the Boundary Selection section.

3 From the Selection list, choose Box 15 - x > 0 Spring Anchor.

Size 1
1 Right-click Mapped 1 and choose Size.

2 In the Settings window for Size, locate the Element Size section.

3 Click the Custom button.

4 Locate the Element Size Parameters section.

5 Select the Maximum element size checkbox. In the associated text field, type 
mesh_factor*x_spring_w/2.

6 Select the Minimum element size checkbox. In the associated text field, type 
mesh_factor*x_spring_w/10.

Size
1 In the Model Builder window, under Component 1 (comp1) > Mesh 1 click Size.

2 In the Settings window for Size, locate the Element Size section.

3 Click the Custom button.

4 Locate the Element Size Parameters section. In the Maximum element size text field, type 
mesh_factor*tether_w/3.

5 In the Minimum element size text field, type mesh_factor*tether_w/30.

6 In the Maximum element growth rate text field, type 1.1+mesh_factor*0.2.

Copy Face 1
1 In the Mesh toolbar, click Copy and choose Copy Face.

2 In the Settings window for Copy Face, locate the Source Boundaries section.

3 From the Selection list, choose Box 15 - x > 0 Spring Anchor.

4 Locate the Destination Boundaries section. From the Selection list, choose Box 16 -

x < 0 Spring Anchor.
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Free Quad 1
1 In the Mesh toolbar, click More Generators and choose Free Quad.

2 In the Settings window for Free Quad, locate the Boundary Selection section.

3 From the Selection list, choose Difference 1 - Quad Mesh - Springs.

Size 1
1 Right-click Free Quad 1 and choose Size.

2 In the Settings window for Size, locate the Geometric Entity Selection section.

3 Click Clear Selection.

4 Select Boundaries 945 and 950 only.

5 Locate the Element Size section. Click the Custom button.

6 Locate the Element Size Parameters section.

7 Select the Maximum element size checkbox. In the associated text field, type 
mesh_factor*x_spring_w/3.

8 Select the Minimum element size checkbox. In the associated text field, type 
mesh_factor*x_spring_w/30.

Copy Face 2
1 In the Mesh toolbar, click Copy and choose Copy Face.

2 In the Settings window for Copy Face, locate the Source Boundaries section.

3 From the Selection list, choose Difference 1 - Quad Mesh - Springs.

4 Locate the Destination Boundaries section. From the Selection list, choose Difference 2 -

Quad Mesh - Springs copy.

5 Click Build Selected.

Size 1
1 In the Model Builder window, right-click Size and choose Duplicate.

2 In the Settings window for Size, locate the Element Size Parameters section.

3 In the Maximum element size text field, type mesh_factor*w_rotor/2.

4 In the Minimum element size text field, type mesh_factor*w_rotor/20.

Free Quad 2
1 In the Mesh toolbar, click More Generators and choose Free Quad.

2 In the Settings window for Free Quad, locate the Boundary Selection section.

3 From the Selection list, choose Difference 3 - Quad Mesh -Stator & Comb.
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Copy Face 3
1 In the Mesh toolbar, click Copy and choose Copy Face.

2 In the Settings window for Copy Face, locate the Source Boundaries section.

3 From the Selection list, choose Difference 3 - Quad Mesh -Stator & Comb.

4 Locate the Destination Boundaries section. From the Selection list, choose Difference 4 -

Quad Mesh -Stator & Comb copy.

5 Click Build Selected.

Size 2
1 In the Model Builder window, under Component 1 (comp1) > Mesh 1 right-click Size 1 and 

choose Duplicate.

2 In the Settings window for Size, locate the Element Size Parameters section.

3 In the Maximum element size text field, type mesh_factor*w_rotor.

4 In the Minimum element size text field, type mesh_factor*w_rotor/10.

Free Triangular 1
1 In the Mesh toolbar, click More Generators and choose Free Triangular.

2 In the Settings window for Free Triangular, locate the Boundary Selection section.

3 From the Selection list, choose Intersection 7 - Triangular Mesh - Mass.

Copy Face 4
1 In the Mesh toolbar, click Copy and choose Copy Face.

2 In the Settings window for Copy Face, locate the Source Boundaries section.

3 From the Selection list, choose Intersection 7 - Triangular Mesh - Mass.

4 Locate the Destination Boundaries section. From the Selection list, choose Intersection 8 -

Triangular Mesh - Mass copy.

Free Triangular 2
1 In the Mesh toolbar, click More Generators and choose Free Triangular.

2 In the Settings window for Free Triangular, locate the Boundary Selection section.

3 From the Selection list, choose Intersection 9 - Triangular Mesh - Sense Electrode.

Copy Face 5
1 In the Mesh toolbar, click Copy and choose Copy Face.

2 In the Settings window for Copy Face, locate the Source Boundaries section.

3 From the Selection list, choose Intersection 9 - Triangular Mesh - Sense Electrode.
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4 Locate the Destination Boundaries section. From the Selection list, choose 
Intersection 10 - Triangular Mesh - Sense Electrode copy.

Swept 1
1 In the Mesh toolbar, click Swept.

2 In the Settings window for Swept, locate the Domain Selection section.

3 From the Geometric entity level list, choose Domain.

4 From the Selection list, choose Box 2 - Entire Beam Layer.

Distribution 1
1 Right-click Swept 1 and choose Distribution.

2 In the Settings window for Distribution, locate the Distribution section.

3 In the Number of elements text field, type max(1,floor(3/mesh_factor)).

Swept 2
1 In the Mesh toolbar, click Swept.

2 In the Settings window for Swept, locate the Domain Selection section.

3 From the Geometric entity level list, choose Domain.

4 From the Selection list, choose Extrude 2 - Anchors.

Distribution 1
1 Right-click Swept 2 and choose Distribution.

2 In the Settings window for Distribution, locate the Distribution section.

3 In the Number of elements text field, type max(1,floor(3/mesh_factor)).
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4 In the Mesh toolbar, click Build Mesh.

Perform the stationary study.

S T U D Y  1  -  S T A T I O N A R Y

1 In the Model Builder window, click Study 1.

2 In the Settings window for Study, type Study 1 - Stationary in the Label text field.

3 In the Study toolbar, click Compute.
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R E S U L T S

Stress (solid)

The plot shows that the masses are pulled down slightly by the bias voltage of the sense 
electrodes. The masses do not move horizontally since the DC part of the comb drive 
forces for each mass are equal and in opposite directions so they cancel out.

Next perform a prestressed eigenfrequency study to find the drive and sense mode 
frequencies.

A D D  S T U D Y

1 In the Home toolbar, click Add Study to open the Add Study window.

2 Go to the Add Study window.

3 Find the Studies subsection. In the Select Study tree, select 
Preset Studies for Selected Physics Interfaces > Eigenfrequency, Prestressed.

4 Click the Add Study button in the window toolbar.

5 In the Home toolbar, click Add Study to close the Add Study window.

S T U D Y  2  -  P R E S T R E S S E D  E I G E N F R E Q U E N C Y

In the Settings window for Study, type Study 2 - Prestressed Eigenfrequency in the 
Label text field.
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Step 2: Eigenfrequency
1 In the Model Builder window, under Study 2 - Prestressed Eigenfrequency click 

Step 2: Eigenfrequency.

2 In the Settings window for Eigenfrequency, locate the Study Settings section.

3 Select the Desired number of eigenfrequencies checkbox. In the associated text field, type 
3.

4 In the Search for eigenfrequencies around shift text field, type 38000[Hz].

5 From the Search method around shift list, choose Larger real part.

6 In the Study toolbar, click Compute.

R E S U L T S

Mode Shape (solid)

The plot shows the drive mode, ...
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1 In the Settings window for 3D Plot Group, click Plot Next.

... and the sense mode.

Before continuing to the next study, we use analytic formulas to estimate the drive and 
sense mode frequencies, to compare with the numerical result. The global parameter table 
serves well for this kind of back-of-the-envelope calculations. In particular, the capability 
of including units in the calculation helps detect mistakes. First compute the drive mode. 
The total mass of the resonator is calculated straightforwardly. The spring constants of 
each segment of the spring for the drive mode is estimated using standard formulas in 
textbooks such as Ref. 2 (section 4.3 Spring design equations). From the mode shape of 
the drive mode, the formula for guided beams is used.

G L O B A L  D E F I N I T I O N S

Parameters 3 - Estimate drive mode frequency
1 In the Home toolbar, click Parameters and choose Add > Parameters.

2 In the Settings window for Parameters, type Parameters 3 - Estimate drive mode 
frequency in the Label text field.
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3 Locate the Parameters section. In the table, enter the following settings:

The estimated drive mode frequency of 40 kHz is not too far away from the computed 
value of 38 kHz. Next the sense mode, which involves both bending and twisting of the 
springs. Therefore the formulas for both guided beams and torsional springs are used in 
the estimation.

Parameters 4 - Estimate sense mode frequency
1 In the Home toolbar, click Parameters and choose Add > Parameters.

Name Expression Value Description

rho0 2320[kg/m^3] 2320 kg/m³ Density

m0 rho0*t_beam*2*
(2*n_combs*
l_rotor*w_rotor+
l_mass*w_mass-
n_etch_x*
n_etch_y*
etch_dim^2)

2.2272E-9 kg Total mass

E0 160e9[Pa] 1.6E11 Pa Young's modulus

I0 t_beam*
x_spring_w^3/12

6.4E-23 m4 Area moment of 
inertia for X 
spring in-plane 
bending

k0 4*12*E0*I0/
x_spring_l^3

145.64 N/m Spring constant 
for X spring in-
plane bending

I1 t_beam*
y_spring_w^3/12

1E-21 m4 Area moment of 
inertia for Y 
spring in-plane 
bending

y_spring_l3 y_spring_l/2-
tether_x

1.2E-4 m Length of Y spring 
between tether 
and X spring

k1 4*12*E0*I1/
y_spring_l3^3

4444.4 N/m Spring constant 
for Y spring in-
plane bending

k_tot 1/(1/k0+1/k1) 141.01 N/m Total spring 
constant for in-
plane bending

f0 sqrt(k_tot/m0)/
2/pi

40047 1/s Estimated drive 
mode frequency
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2 In the Settings window for Parameters, type Parameters 4 - Estimate sense mode 
frequency in the Label text field.
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3 Locate the Parameters section. In the table, enter the following settings:

The estimated sense mode frequency of 45 kHz is also not too far away from the 
computed value of 41 kHz, especially given the complicated bending and twisting 
configuration of the sense mode. Now we perform a prestressed frequency domain 

Name Expression Value Description

I2 t_beam^3*
x_spring_w/12

5.76E-22 m4 Area moment of 
inertia for X spring 
out-of-plane 
bending

k2 4*12*E0*I2/
x_spring_l^3

1310.7 N/m Spring constant for 
X spring out-of-
plane bending

I3 t_beam^3*
y_spring_w/12

1.44E-21 m4 Area moment of 
inertia for Y spring 
out-of-plane 
bending

k3 4*12*E0*I3/
y_spring_l3^3

6400 N/m Spring constant for 
Y spring out-of-
plane bending

I4 t_beam^3*tether_w/
12

1.152E-21 m4 Area moment of 
inertia for tether 
beam out-of-plane 
bending

k4 4*12*E0*I4/
tether_l^3

5120 N/m Spring constant for 
tether beam out-of-
plane bending

G0 80[GPa] 8E10 Pa Shear modulus

k_th G0*t_beam*
tether_w^3/
tether_l*(1/3-
0.21*tether_w/
t_beam*(1-
((tether_w/
t_beam)^4)/12))

8.0133E-7 J Torsional spring 
constant of tether 
beam

k5 4*k_th/
y_spring_l3^2

222.59 J/m² Spring constant 
from torsion of 
tether beams

k_tot2 1/(1/k2+1/k3+1/k4+
1/k5)

178.35 N/m Total spring 
constant for out-
of-plane bending

f1 sqrt(k_tot2/m0)/2/
pi

45038 1/s Estimated sense 
mode frequency
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study to calculate the drive mode AC amplitude and the sense mode AC signal as a 
function of the rotation speed. First enter the drive mode frequency from the previous 
study result into the parameter table.

Parameters 5 - Result from Study 2
1 In the Home toolbar, click Parameters and choose Add > Parameters.

2 In the Settings window for Parameters, type Parameters 5 - Result from Study 2 
in the Label text field.

3 Locate the Parameters section. In the table, enter the following settings:

Then set up the prestressed frequency domain study. Note how the parameter AC_on is 
used to turn on the AC drive in the second study step (Frequency Domain Perturbation).

A D D  S T U D Y

1 In the Home toolbar, click Add Study to open the Add Study window.

2 Go to the Add Study window.

3 Find the Studies subsection. In the Select Study tree, select 
Preset Studies for Selected Physics Interfaces > Frequency Domain, Prestressed.

4 Click the Add Study button in the window toolbar.

5 In the Home toolbar, click Add Study to close the Add Study window.

S T U D Y  3  -  P R E S T R E S S E D  F R E Q U E N C Y  D O M A I N

In the Settings window for Study, type Study 3 - Prestressed Frequency Domain in 
the Label text field.

Step 2: Frequency-Domain Perturbation
1 In the Model Builder window, under Study 3 - Prestressed Frequency Domain click 

Step 2: Frequency-Domain Perturbation.

2 In the Settings window for Frequency-Domain Perturbation, locate the Study Settings 
section.

3 In the Frequencies text field, type fd.

4 Click to expand the Study Extensions section. Select the Auxiliary sweep checkbox.

5 From the Sweep type list, choose All combinations.

6 Click Add.

Name Expression Value Description

fd 38262[Hz] 38262 Hz Drive frequency (from computed 
drive-mode eigenfrequency)
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7 In the table, enter the following settings:

8 Click Add.

9 In the table, enter the following settings:

10 In the Study toolbar, click Compute.

R E S U L T S

Stress (solid) 1
Create some plots to examine the result. First look at the drive mode amplitude.

Imag X displacement - Drive mode amplitude
1 Right-click Stress (solid) 1 and choose Duplicate.

2 In the Settings window for 3D Plot Group, type Imag X displacement - Drive mode 
amplitude in the Label text field.

3 Click to expand the Title section. From the Title type list, choose Manual.

4 In the Title text area, type Drive mode amplitude (µm).

5 Locate the Plot Settings section. From the Frame list, choose Material (X, Y, Z).

6 Locate the Color Legend section. Select the Show maximum and minimum values 
checkbox.

Volume 1
1 In the Model Builder window, expand the Imag X displacement - Drive mode amplitude 

node, then click Volume 1.

2 In the Settings window for Volume, locate the Expression section.

3 In the Expression text field, type imag(u).

Deformation
1 In the Model Builder window, expand the Volume 1 node, then click Deformation.

2 In the Settings window for Deformation, locate the Expression section.

3 In the x-component text field, type imag(u).

Parameter name Parameter value list Parameter unit

AC_on (1 to turn on AC drive, 0 
otherwise)

1

Parameter name Parameter value list Parameter unit

Omega (Angular rotation rate) 0 100 deg/s
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4 In the y-component text field, type imag(v).

5 In the z-component text field, type imag(w).

6 In the Imag X displacement - Drive mode amplitude toolbar, click Plot.

We see that the drive mode amplitude is about 2.4 um. This can be compared to an 
estimation using an analytic formula. This gives a good estimate of 2.2 um (see 
instructions below). The formula for the amplitude as a function of applied force, Q 
factor, and spring constant can be found in standard textbooks such as Ref. 2 (Appendix 
B).

G L O B A L  D E F I N I T I O N S

Parameters 6 - Estimate drive mode amplitude
1 In the Home toolbar, click Parameters and choose Add > Parameters.

2 In the Settings window for Parameters, type Parameters 6 - Estimate drive mode 
amplitude in the Label text field.
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3 Locate the Parameters section. In the table, enter the following settings:

Create some plots to look at the sense mode response.

R E S U L T S

Real Z displacement - No rotation
1 In the Model Builder window, right-click Stress (solid) 1 and choose Duplicate.

2 In the Settings window for 3D Plot Group, type Real Z displacement - No rotation 
in the Label text field.

3 Locate the Data section. From the Parameter value (Omega (deg/s)) list, choose 0.

4 Locate the Plot Settings section. From the Frame list, choose Material (X, Y, Z).

5 Locate the Color Legend section. Select the Show maximum and minimum values 
checkbox.

Volume 1
1 In the Model Builder window, expand the Real Z displacement - No rotation node, then 

click Volume 1.

2 In the Settings window for Volume, locate the Expression section.

3 In the Expression text field, type w.

4 Clear the Compute differential checkbox.

Deformation
1 In the Model Builder window, expand the Volume 1 node, then click Deformation.

2 In the Settings window for Deformation, locate the Expression section.

3 In the z-component text field, type w*1e3.

Name Expression Value Description

n_overlaps 2*n_combs*4 64 Total number of comb 
drive electrode 
overlaps

F_comb_dc n_overlaps*
epsilon0_const*
t_beam*Vcomb^2/(2*
gap_combs)

6.12E-6 N DC comb force

F_comb_ac 2*F_comb_dc*V_ac/
Vcomb

6.12E-7 N AC comb force

u_ac0 F_comb_ac*Q/k_tot 2.17E-6 m Estimated drive mode 
AC amplitude
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4 In the Real Z displacement - No rotation toolbar, click Plot.

Real Z Displacement - Rotation
1 In the Model Builder window, right-click Real Z displacement - No rotation and choose 

Duplicate.

2 In the Settings window for 3D Plot Group, type Real Z Displacement - Rotation in 
the Label text field.

3 Locate the Data section. From the Parameter value (Omega (deg/s)) list, choose 100.

4 In the Real Z Displacement - Rotation toolbar, click Plot.

Real Z displacement - Net sense signal
1 Right-click Real Z Displacement - Rotation and choose Duplicate.

2 In the Settings window for 3D Plot Group, type Real Z displacement - Net sense 
signal in the Label text field.

3 Locate the Title section. From the Title type list, choose Manual.

4 In the Title text area, type Sense mode amplitude (µm).

Volume 1
1 In the Model Builder window, expand the Real Z displacement - Net sense signal node, 

then click Volume 1.

2 In the Settings window for Volume, locate the Expression section.

3 In the Expression text field, type w-withsol('sol4',w,setind(Omega,1)).

Deformation
1 In the Model Builder window, expand the Volume 1 node, then click Deformation.

2 In the Settings window for Deformation, locate the Expression section.

3 In the x-component text field, type u-withsol('sol4',u,setind(Omega,1)).

4 In the y-component text field, type v-withsol('sol4',v,setind(Omega,1)).

5 In the z-component text field, type (w-withsol('sol4',w,setind(Omega,1)))*1e3.
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6 In the Real Z displacement - Net sense signal toolbar, click Plot.

By clicking on the center of each proof mass in the plot and look at the result in the 
Evaluation 3D table, we see that the sense mode amplitude is about 0.20 nm. This can 
be compared to an estimation using an analytic formula. This gives a good estimate of 
0.21 nm (see instructions below). The calculation of the Coriolis force can be found in 
standard textbooks such as Ref. 2 (Chapter 22).

G L O B A L  D E F I N I T I O N S

Parameters 7 - Estimate sense mode amplitude
1 In the Home toolbar, click Parameters and choose Add > Parameters.

2 In the Settings window for Parameters, type Parameters 7 - Estimate sense mode 
amplitude in the Label text field.
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3 Locate the Parameters section. In the table, enter the following settings:

As an alternative to reading values off the graphs, in the following steps we show how to 
use the Evaluation Group tool to evaluate the displacement values. First create an average 
operator and update the solution so that the newly created operator will be recognized by 
the solution dataset.

D E F I N I T I O N S

Average 1 - Lower Electrodes
1 In the Definitions toolbar, click Nonlocal Couplings and choose Average.

2 In the Settings window for Average, type Average 1 - Lower Electrodes in the Label 
text field.

3 In the Operator name text field, type aveoppp.

4 Locate the Source Selection section. From the Geometric entity level list, choose 
Boundary.

Name Expression Value Description

fs 41129[Hz] 41129 Hz Computed sense mode 
eigenfrequency

k_from_fd m0*(2*pi*fd)^2 128.72 N/m Total spring 
constant from 
computed drive mode 
frequency

u_ac0_from_f
d

F_comb_ac*Q/
k_from_fd

2.3772E-6 m Drive mode AC 
amplitude from 
computed frequency

v_ac0_from_f
d

u_ac0_from_fd*2*
pi*fd

0.5715 m/s Drive mode velocity 
amplitude from 
computed frequency

F_c 2*m0*
v_ac0_from_fd*
100[deg/s]

4.4431E-9 N Coriolis force

k_from_fs m0*(2*pi*fs)^2 148.74 N/m Spring constant from 
computed sense mode 
frequency

u_s_at_fs F_c*Q/k_from_fs 1.4936E-8 m Sense mode amplitude 
if driven at sense 
frequency

u_s u_s_at_fs/
sqrt(1+Q^2*(fd/
fs-fs/fd)^2)

2.0651E-10 m Estimated sense mode 
amplitude at drive 
frequency
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5 From the Selection list, choose Union 7 - Lower electrode effective region.

S T U D Y  1  -  S T A T I O N A R Y

In the Study toolbar, click Update Solution.

R E S U L T S

Evaluation Group 1 - Study 1 - Stationary
1 In the Results toolbar, click Evaluation Group.

2 In the Settings window for Evaluation Group, type Evaluation Group 1 - Study 1 - 
Stationary in the Label text field.

Global Evaluation 1
1 Right-click Evaluation Group 1 - Study 1 - Stationary and choose Global Evaluation.

2 In the Settings window for Global Evaluation, locate the Expressions section.

3 In the table, enter the following settings:

4 In the Evaluation Group 1 - Study 1 - Stationary toolbar, click Evaluate.

Continue to use the Evaluation Group tool to evaluate the drive mode and sense mode 
amplitudes for the prestressed frequency domain study.

In addition, compute the sensitivity in terms of the sense capacitance change per rotation 
rate, in the units of aF/(deg/s). Two alternatives are used below. The first one integrates 
the capacitance per unit area variable C_A defined earlier over the effective region of the 
lower electrodes. Note the use of the sign variable for the AC signal, and the use of the 
Compute differential checkbox to evaluate the correct small signal amplitude of the variable 
C_A, which is a nonlinear function of the dependent variables (alternatively, the lindev 
operator can be used with the checkbox cleared). The other one estimates the capacitance 
change by taking the derivative of the analytic parallel plate capacitance with respect to the 
gap size and multiplying by the sense mode amplitude. Both methods produced very 
similar results. It can be useful to evaluate the sense capacitance amplitude without 
dividing by the rotation rate, as shown in the last row of the global evaluation table.

S T U D Y  3  -  P R E S T R E S S E D  F R E Q U E N C Y  D O M A I N

In the Study toolbar, click Update Solution.

Expression Unit Description

aveoppp(w) µm Average Z displacement
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R E S U L T S

Evaluation Group 2 - Study 3 - Prestressed Frequency Domain
1 In the Model Builder window, right-click Evaluation Group 1 - Study 1 - Stationary and 

choose Duplicate.

2 In the Settings window for Evaluation Group, type Evaluation Group 2 - Study 3 - 
Prestressed Frequency Domain in the Label text field.

3 Locate the Data section. From the Dataset list, choose Study 3 -

Prestressed Frequency Domain/Solution 4 (sol4).

4 From the Parameter selection (Omega) list, choose Last.

Global Evaluation 1
1 In the Model Builder window, expand the Evaluation Group 2 - Study 3 -

Prestressed Frequency Domain node, then click Global Evaluation 1.

2 In the Settings window for Global Evaluation, locate the Expressions section.

3 In the table, enter the following settings:

4 Select the Compute differential checkbox.

5 In the Evaluation Group 2 - Study 3 - Prestressed Frequency Domain toolbar, click 
Evaluate.

Expression Unit Description

aveoppp(imag(sign*u)) µm Drive mode amplitude

aveoppp(real(sign*w)) µm Sense mode amplitude

intoppp(sign*C_A)/Omega/1[aF/
(deg/s)]

1 Sensitivity (aF/(deg/s))

-aveoppp(real(sign*w))*
epsilon0_const*intoppp(1)/
t_anchor^2/Omega/1[aF/(deg/s)]

1 Estimated sensitivity

intoppp(sign*C_A) aF Sense capacitance 
amplitude
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